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USING THIS MANUAL 
 
1.1. OVERVIEW 
 

 The MARC OMNII-COMM is a microprocessor-based multi-port 
communications module. The module is available as a single slot module for the 
Allen-Bradley PLC 5 or SLC 500, a single slot module for a Reliance Automate, 
and as a stand alone unit. The single slot PLC modules connect to the PLC 
backplane for +5V power only. The stand alone units are available with either a 
universal input AC supply or a 24VDC supply. Optional on-board leased line and 
dial-up modems can be added to the Omnii-Comm to provide extended 
communication capability for use over telephone lines, twisted pair and radio 
networks.  Each port of the OMNII-COMM is uniquely configurable for 
protocol, communicaton parameters (baud rate, number of data bits, etc.) and for 
Master or Slave emulation. The configuration software runs on any standard PC.  
No PLC programming is required. 

 
1.2  MANUAL’S PURPOSE 
 
  This manual tells how to install and operate the OMNII-COMM.  The 
 manual covers the following areas: 
 

• Hardware Specifications 
• Installation of the OMNII-COMM 
• Functional Operation 
• Configuration Information 

 
  The OMNII-COMM supports a wide variety of communication protocols 

 and others are currently under development. 
 
 
NOTE: WHEN THE NAME “OMNII-COMM” IS USED IN THIS MANUAL, IT 

CAN REFER TO THE 166-500, 166-201/202/203/206, AND THE 266-001/002.  
THE OMNII-COMM AND PROTOCOL CONVERTER BOTH BELONG 
TO THE “OMNII-COMM FAMILY” OF COMMUNICATION MODULES,  
THEREFORE  THEY CAN OPERATE AND BE CONFIGURED THE SAME  
WAY.  THE PROTOCOL CONVERTER IS COVERED UNDER THE 
NAME “OMNII-COMM” IN THIS MANUAL. 
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GENERAL DESCRIPTION 
 
 
 

2.1  OBJECTIVES 
 
  This section discusses the various models of the OMNII-COMM.  After 
 finishing this section the reader should: 
 

• Understand and be able to identify the hardware components of the 
OMNII-COMM. 

• Understand the basic features and functions of the OMNII-COMM. 
 
2.2  MODELS 
 
  The following listed models are all members of the OMNII-COMM 
 family. 
 
  166-500-XXX for the PLC-5 processor 
              166-201   for the SLC processor with Leased-Line modem 
                     166-202   for the SLC processor with Dial-Up modem 
                     166-203   for the SLC processor  
  166-206  for the SLC processor with 3rd RS-232 port 
                     266-001-XXX Protocol Converter, stand-alone or 19”rack mounted, 24VDC 
                     266-002-XXX Protocol Converter, stand-alone or 19”rack mounted, 120VAC 
 
2.3 GENERAL FEATURES 
 

 An Omnii-Comm base module(166-500, 266-001/002) comes with Port 1 
and Port 2 enabled for RS-232 or RS-422/485 communication.  With optional add-
on modules, the 166-500 and 266-001/002 can communicate using up to five ports at 
a time, where each port can use a different protocol.  The Omnii-Comm for the SLC 
processors (166-20X) have a maximum of 3 ports. 

     
  
2.4  OPTIONS 
 

 The customer can purchase optional add-on modules for the 166-500 and 
266-001/002 versions of the Omnii-Comm.  After the base module part number, for 
example a 166-500, there can be an options suffix (166-500-xxx).  The part number 
166-500-422, for example, indicates that a customer wishes to add an RS-422/485 
driver/receiver to both Port 3 and Port 4, and add a 1200 baud Leased-Line modem 
module to the modem port.  The options are as follows: 
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2.4  OPTIONS (Continued) 
 
                                 -1    RS-232 driver/receiver for P3 or P4 
                                 -2    RS-422/485 driver/receiver for P3 or P4 
                                 -3    2400 baud dial-up modem for P3, P4 or Modem port. 
                                 -4    1200 baud leased-line modem for Modem port 
                                 -5    14.4kbps dial-up modem for P3, P4 or Modem port 
                                 -6    RS-232 driver/receiver for the modem port on the 166-203 
                                 -7    RS-422/485 driver/receiver for the modem port on the 166-203 
 

These add-on modules may be purchased and installed on the Omnii-Comm 
at any time. 

 
 
2.5  SPECIFICATIONS  
 

 The Omnii-Comm cards (besides the 266-001/002) mount in the Allen-
Bradley or Reliance PLC racks.  The166-500 mounts in the 1771-I/O chassis, and 
the 166-201/202/203/206 mounts in the 1746-I/Ochassis.   Both versions pull 5 volts 
from the chassis backplane.  The 166-20X draws 100mA from the 1746-I/O chassis, 
while the 166-500 draws 1A from the 1771-I/O chassis.  The Omnii-Comm is slot-
independent in the chassis, and can be placed in any empty slot; the slot requires no 
configuration.  The Omnii-Comm cannot communicate over the chassis backplane, 
and must communicate through the 9-pin serial ports or the modem ports.      
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CONFIGURATION PROGRAM 
 

3.1  PROGRAMMING CONCEPTS 
 

 The fundamental areas of Omnii-Comm operation are as follows: 
 

 3.1.1  Configuration 
 

The Omnii Config program lets the user build a configuration file.  
When this configuration file is saved, Omnii Config creates a .S19 file that the 
Omnii-Comm needs to run.  Download this file to P1 of the Omnii-Comm using 
an RS-232 cable with a null-modem connected to a serial port on the Personal 
Computer.  In order to receive a .S19 file, the Omnii-Comm needs to be in the 
setup mode; press the black button on the Omnii-Comm to put it into the setup 
mode.  The active light should be on solid (not blinking) after pushing the black 
button.  The .S19 program may be stored in temporary RAM or permanent 
EEPROM.  Run the Omnii-Comm from RAM to test the preliminary program.  
For final operation, run the Omnii-Comm from EEPROM by transferring the 
.S19 program to EEPROM from RAM and making EEPROM active. 

  
 3.1.2  Port Selection 
 

The 166-500 and 266-001/2 supports up to five ports.  The 166-20X 
supports up to three ports.  Each port can communicate using a different 
protocol, baud rate, etc.  Remember to configure the ports on the PLC or related 
device with matching baud rate, protocol, error checking, etc. as the connecting 
port on the Omnii-Comm. 

These ports can be hardware configured to use either RS-232 or RS-
422/485 serial interface signal levels.  Remember that RS-232 and RS-422 are 
for point-to-point full-duplex communications, and that RS-485 is used in half-
duplex point-to-multipoint communications.  Ports P1 and P2 require a certain 
jumper configuration (described in the Hardware chapter of this manual) while 
P3-P5 depend on the add-on board selected at purchase. 

 
 3.1.4  Polling Tables 
 

Data is transferred through the various ports of the Omnii-Comm 
according to the Poll Tables.  Each poll table tells the Omnii-Comm which port 
to read data from and which port to write data to -unless the Omnii-Comm 
emulates a slave device, in which case the poll table writes to an internal 
database set up to emulate a slave device.  The poll table also specifies what 
addresses to be read/written, the amount of data to be read/written and an error 
location to place an error code if there is a problem with the poll instruction.  
There is only one read/write instruction per poll table, and a maximum of thirty 
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two poll tables.  The maximum number of bytes the poll table can transfer 
depends on the two protocols used for that specific poll table. 

If the Omnii-Comm is a master to two devices, the poll table will read 
from one port and write to another port.  If the Omnii-Comm is a master to one 
device and a slave to another, the Omnii-Comm reads from the master port and 
writes the data to the database.  This database will mirror the data in the device 
connected to the master port; any data change in the device the poll table reads 
from will change the data in the database and any write to the database thru the 
Omnii-Comm’s slave port will update the data in the device the poll table reads 
from. 

If the program consists of multiple poll tables, any poll tables that write 
data to the database need to be done before any poll tables that write data to a 
connector.  The order in which the poll tables are set up determines the order of 
registers within the database.  For example, if poll table 1 writes two registers to 
the data base and poll table 2 writes three registers to the database, the third 
register in the database, as seen by the slave, is actually the first register written 
from poll table 2. 

 
 3.1.5   Modem Capabilities 
 

The Omnii-Comm 166-500-XXX has the internal modem capability of 
two dial-up modems and one leased-line modem.  If a leased-line modem is 
used, it is configured as the Modem port in the Connector section of the 
configuration program.  In the configuration program, dial-up modems can be 
connected to Port 3, Port 4, or the Modem port.  The Omnii-Comm 166-20X 
only has one modem option- either a leased line or a dial-up.  The dial-up 
modems can autoanswer, but they cannot dial out. 

 
 
3.2  COMMANDS 
 

This section covers the commands and options of the Omnii-Config 
software.  Type “config” to start the menu-driven program. 

 
 
 3.2.1  The FILE menu 
 

NEW:   This command tells the software to start a new configuration file. 
 
OPEN:         This brings up a list of previously saved files to open. 
 
SAVE:         This saves changes to the current file. 
 



OMNII-COMM 
CONFIGURATION PROGRAM     
 

6 

 
SAVE AS:   This names the current file and saves it to the directory of choice.  
 
ERASE:       This erases the current file. 
 
DISPLAY:   This displays a summary of the configuration parameters for the 

current file. 
 
PRINT: This prints a summary of the configuration parameters for the 

current file. 
 

EXIT:  This returns to DOS. 
 

 
 3.2.2  The EDIT menu 
 

PROTOCOL MAINTENANCE   
 

Add or delete protocols used by the configuration program from the 
current set before opening a configuration program; the protocols used in the 
program must be in the current set. 
 
CONNECTOR SCREEN   
 

The following is a list of command buttons for the Connector screen: 
 

CHANNEL:    This selects an internal UART channel for the processor to 
communicate with an enabled port.  Each port requires a unique UART 
setting- no two ports can use the same UART.  Port P1, port P2 and the 
modem port can be assigned UART1 CH A, UART1 CH B or HC11 
UART.  However, the HC11 UART only supports Configuration, A-B 
DF1 F/D or A-B DF1 H/D protocols.  P3 must be UART2 CH A, and P4 
must be UART2 CH B.   

Port P1 is used for downloading the configuration file.  It is 
automatically set up at power on if no configuration file is loaded, and is 
set to configuration when the black button is pushed.  You may 
configure Port P1 for any protocol, but if it is an “extra” port, 
configuring it to “configuration” protocol allows the user to debug the 
application. 

Remember that Ports 3 & 4 can be loaded with optional dial-up 
modem modules, as well as RS-232 or RS-422/485 line drivers. 

 
PREVIOUS:   This brings up the parameters for the previous port on the 

Connector Selection screen. 
 



OMNII-COMM 
CONFIGURATION PROGRAM     
 

7 

 
NEXT: This takes the user to the next port definition on the Connector 

Selection screen.            
 

DISABLE:  This disables the current port. 
 

SAVE:   This saves the current port configuration.  Hit the save button each 
time a port is configured, otherwise, changes are not saved. 

 
EXIT:   This exits from the Connector Selection screen. 

 
 

Besides the command buttons, there are several parameters that can be defined 
for each port.  Not all of these options will be available for every protocol. 
 

PROTOCOL:    Select a protocol from the “Current Set” (in the 
“Protocol Maintenance” menu) to assign to a particular port. 

 
RTS ON DELAY X10ms:  The carrier signal will precede any 
transmissions by this number multiplied by 10ms. This is useful then 
connecting the Omnii-Comm to a radio, as this will “key-up” a radio in 
advance before the message is sent to the radio. 

 
RTS OFF DELAY X10ms:  The carrier signal will turn off after any 
transmissions according to this number multiplied by 10ms.  This is 
useful for using the Omnii-Comm with a radio, as this will allow the 
complete message to be sent before the radio turns off. 

 
ENABLE[ ] DIAL MODEM:    If there is a dial-up modem module in 
Port 3, Port 4, or the “modem” port, this gives the option of assigning a 
“Hayes” compatible ASCII string to customize the auto-answer 
functions of the modem.  Note: at this time, the dial-up modems come 
from the factory set to answer after one ring, and they do not support 
dial-out functions, i.e., they are for auto-answer applications. 

 
ENABLE[ ] PROTOCOL:  This will allow the Omnii-Comm to use 
special protocol specific functions when needed.  See the on-line help 
file for specific protocol information. 

 
MASTER or SLAVE:  The Omnii-Comm has the option of being a 
master for most protocols, and a slave for some protocols.  Click on the 
box to select a Master function.  If the Omnii-Comm is configured as a 
slave, remember to assign a slave “RTU Address” for the Omnii-Comm 
in the “Header” menu.                                                 
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ERROR CHECK BCC/CRC:   Select a preferred error checking 
method by clicking on the selection box.  Use CRC for the A-B DF1 
protocols.  See the “Help” file on the specific protocol for information 
regarding the error checking scheme for the particular protocol. 

 
There can be several different options that appear on the Connector Selection 
screen depending on the protocol that is assigned to the current port.  Please 
refer to the on-line help utility for the protocol of your choice to read a detailed 
explanation of these options. 

 
 
 The HEADER menu 
 

The following is a list of parameters to be defined in the Header screen. 
 
DATABASE PROTOCOL:  If a connector on the Omnii-Comm is a 
slave, select the database protocol to match the slave protocol.  See the 
on-line help file for the specific protocol for a detailed explanation of 
the database structure for that protocol. 

 
RTU ADDRESS:   This is the slave address of the Omnii-Comm’s 
database as seen by a master unit.  Set this to “0” if the Omnii-Comm 
will not be a slave. 

 
OMNII-COMM ADDX:      This is the Omnii-Comm address to the 
system when the Omnii-Comm will be a master unit.  Make sure that the 
Omnii-Comm does not have the same address as some other unit in the 
system that it is polling. 
 
POLL TIMER MUL: This number will be multiplied by 
(10ms)*(Repeat/Poll rate) in the “Poll Table” selection screen to setup 
the frequency of each poll table.  

 
RADIO KEY ADDX:   This is an address in a  PLC that can be set to 
trigger a contact closing to key-up a radio.  This is usually taken care of 
nowadays with the “RTS on delay” function.  Set this to “0” if not 
needed. 

 
ERROR TIME OUT:  If there is an error with an Omnii-Comm poll, 
the Omnii-Comm will not attempt that poll again until after the number 
of seconds specified here. 

 
The POLL TABLES menu  
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This section will define how the Omnii-Comm reads and writes data. 

 
APPEND:   This command adds a poll table. 

 
DELETE:   This command deletes the poll table specified in the poll 
table number box. 

 
MOVE UP:  This command moves the current poll table up in the order.  
For example, if poll table 4 is the current poll (in the box), clicking this 
button will switch poll table 4 with poll table 3. 

 
MOVE DOWN:  This command moves the current poll table down in 
the order.  For example, if poll table 4 is the current poll (in the box), 
clicking this button will switch poll table 4 with poll table 5. 

 
SYSTEM ERROR:  This defines a global error location where the 
Omnii-Comm writes system error codes for errors that are not associated 
with specific poll talbes.  The first byte (MSB) of the error code 
indicates the protocol of the communication link with the problem.  The 
second byte (LSB) of the error code indicates the actual problem.  See 
the error codes in the Error Message Definitions chapter. 

 
REPEAT TIMER x 10ms:   This number multiplied by (10ms)*(poll 
timer mul) sets the poll  rate for each poll table.  For example, if the Poll 
Timer Mul = 1, a value of 100 here executes the read/write operation of 
the poll table every (100)*(10ms)*(1) = 1 second, or 1000ms. 

 
POLL TIME OUT x 10ms:  This number, multiplied by 10ms, tells the 
Omnii-Comm how long to wait for a response from a slave unit before 
writing an error message and moving on to the next poll table. 

 
POLL TABLE: This opens the “Table Selections” screen in order to 
define the read/write functions of poll tables. 

 
 Table Selections 
 

 When you enter the “Table Selections” screen, the Read, Write and 
Error buttons will appear.  Read, Write and Error operations must be defined for 
each poll, and, if the write is to the database, the database must be configured 
also.  Each button is described below: 

 
R :       A click on this button tells the software to define a read 
operation. 
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W : A click on this button tells the software to define 
a write operation.  If the current poll writes data to the database,  
click on W and select Database as the Connector.  Then click on 
“Save” and the “EXT” button will appear. 

 
E :        A click on this button opens the error operation to define the 

location for each poll table.  See “System Error” above for more 
details on error codes. 
 

EXT :  This is for the database configuration if the Omnii-Comm is to 
be a slave.  To get this button to appear, follow the instructions 
above concerning the “W” button.  Click on the EXT button to 
set up the database.  See the on-line help file to find detailed 
information on how to set up the database for a specific protocol. 

Remember, if some polls build a database and other poll 
write to a port, the database-building polls must be first. 

 
 
 3.2.3 CONTROL Menu 
 

 Clicking on the Control menu opens the “Omnii-Talk” screen to 
download the configuration file to the Omnii-Comm. 
 

 
OMNIITALK Program 

 
The “Omnii-Talk” opens with the Help menu on the screen; to 

view this screen again, hit the F1 key at any time.  The function of the 
program is to manage the configuration of the Omnii-Comm - download 
the configuration file, select RAM/EEPROM, move file to EEPROM, 
restart the Omnii-Comm, etcetera. 

Note- OmniiTalk establishes a contact with a monitor program in 
the Omnii-Comm that allows the user to examine and change memory 
and perform numerous software moitoring functions.  Typing random 
keys could create random problems: in the worst case, altering the 
restart or interrupt vectors could result in the Omnii-Comm failing 
completely. 
The Omnii-Comm needs to be in the configuration mode in order to 
receive the .S19 file.  Press the black button to put the Omnii-Comm in 
this mode.  The commands are described as follows: 

 
F2 = Stop Polls This command takes the Omnii-Comm out of the 
run mode.  This only works if P1 was configured with the configuration 
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protocol.  This function is only needed to break into a running Omnii-
Comm- the black button stops the Omnii-Comm too. 

 
F3 = Send File to RAM This sends the .S19 file to the Omnii-
Comm’s RAM so the program may be tested.  Once the Omnii-Comm 
loses power, this file is lost. 

 
F4 = Restart Polls This command puts the Omnii-Comm in the run 
mode; the Omnii-Comm either starts polling or sends an error message 
to the screen if there is a configuration error. 

 
F5 = Move RAM to EEPROM This transfers the file in RAM to 
EEPROM.  If the Omnii-Comm loses power, the configuration file will 
not be lost.  As soon as power is turned back on the Omnii-Comm will 
start to run again. 

 
F6 = Change Port This lets the user select which port on the 
Personal Computer to use to download the configuration file from.  This 
program supports comm ports 1 through 4. 
 
F7 = Make RAM Active This command activates RAM.  The 
configuration file in the active memory runs the Omnii-Comm.  The 
Omnii-Comm either runs off of the configuration file in RAM or the one 
in EEPROM. 

 
F8 = Make EEPROM Active This command makes the file in 
EEPROM the operative program for the Omnii-Comm. 

 
F9 = Copy Configuration to File Pulls the current .S19 file out of 
RAM and writes it to a user selectable file name.  Note: the Omnii-
Config program cannot edit this file. 

 
F10 = Save changes, exit to DOS Saves any port settings made and 
exits to DOS. 

 
ALT F1 = Advanced Functions This describes the Advanced 
Functions screen.  These functions are used for debugging purposes. 

 
ALT F2 = Save OmniiComm state to file This saves the entire 
memory of the Omnii-comm, which can be E-mailed to MARC to help 
resolve extreme problems. 

 
ALT F3 = Clear Terminal Buffer This command clears the program 
buffer so saving to a file will not include characters previously typed. 
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ALT F4 = Write Terminal Buffer to Disk This writes any previously 
displayed memory to a file on the disk. 

 
ALT F5 = Save Port Configuration This saves the current port 
settings- COM port, IRQ line, baud rate, number of data bits, number of 
stop bits, and parity. 

 
ALT F6 = Transmit ASCII File This sends an ASCII file to the 
Omnii-Comm. 

 
ALT F7 = Port Configuration Changes This lets the user select the 
port settings- COM port, IRQ line, baud rate, number of data bits, 
number of stop bits, and parity. 

 
ALT F8 = Shell to DOS Commands This opens a temporary 
DOS prompt. 

 
ALT F9 = Show Port Configurations This displays the port 
settings. 

 
ALT F10 = Exit to DOS This exits the Omnitalk program without 
saving the current port settings. 

 
   3.2.4 HELP Menu 
 

 The help menu contains useful information about general configuration 
procedures as well as protocol specific details.  The help file should contain 
information about the protocols that are in the “Current Set” of the “Protocol 
Maintenance” menu. 
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SOFTWARE TUTORIAL       
 
4.1  GENERAL INFORMATION 
  

 The biggest obstacle to a working system is software configuration 
errors.  The fundamental needs for the Omnii-Comm are: 
  

• Configuration header with module address, etc. 
 
• Communication and protocol assignments for each port being used 
 
• Poll tables to direct read/write operations 
 
• Error word locations for diagnostic purposes. 

 
 
4.2  BEFORE STARTING 
 

Before attempting to run the configuration program, select the addresses 
and communication parameters of the various PLCs and related devices for the 
system in which to install the Omnii-Comm.  A checklist for each device in the 
system should verify the following: RTU address or addresses (such as 
processor and station), protocol, baud rate, data bits, stop bits, parity, duplex 
type.  Make sure that an Omnii-Comm port is configured to match its 
compatible port of the device that it communicates with. 
 

 
4.3 PROGRAMMING TUTORIAL 
 

New users should demonstrate the Omnii-Comm with one of the 
following tutorials.  The first configuration consist of one poll table uses the 
read and write functions of the Omnii-Comm as a master to read a word of data 
from an Allen-Bradley PLC and write the data back to the PLC.  The second 
tutorial utilizes the internal database allowing the Omnii-Comm to emulate a 
Modbus slave device. 
 

The equipment used in this demonstration is a PLC5 (with a RS-232 
port), a 166-500 Omnii-Comm base module, a personal computer, a 9-pin serial 
RS-232 cable with a null-modem to connect Port 1 of the Omnii-Comm to a 
serial port on the P.C., a cable (M.A.R.C. cable #127-073-12) to connect the 
PLC5 to Port 2 of the Omnii-Comm, and PLC-5 software.  Set the 
communication parameters for the PLC5 serial port to: 
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After completing this tutorial program, the Omnii-Comm will: 

 Use Port 2 to read 2 bytes from N9:10 of PLC-5 
 Use Port 2 to write the same 2 bytes previously read to N9:11 of PLC-5 
 Write any global error codes to N9:12 of PLC-5 
 Write any poll table error codes to N9:13 of PLC-5 
 
  Example 1 

• 9600 baud 
• 8 data bits 
• 1 stop bit 
• no parity 
• CRC error checking 
• DF-1 Full Duplex                    

 
 

Connect the cable between the PLC5 and Port 2 of the Omnii-Comm, 
and connect the serial cable with the null-modem from a serial port on your P.C. 
to Port 1 of the Omnii-Comm.  Press the black config button to put the Omnii-
Comm in the configuration mode.  The ACTIVE light should be on 
continuously and the Omnii-Comm awaits a configuration file.   

 
Step 1: Go to the directory or disk containing the Omnii-Config software and 
type “config” to start the configuration program. 
 
Step 2: Go to the Edit menu and click on Protocol Maintenance.  Make sure 
that A-B DF-1 F/D is in the current set, then click on Exit/Save. 

 
Step 3: Go to the Edit menu and click on Connector.  The P1 connector screen 
appears.  Since this tutorial does not use connector P1, click on Save to save the 
default settings.   Click on Next to screens to the Port 2 configuration, then click 
on Enable to activate the parameter selection.  Then click on the ↓ by the 
Channel options and choose UART 1 Chan A for Port 2.  This UART lets the 
microprocessor communicate with the port.  Each port requires a unique UART 
setting- no two ports can use the same UART. The communication parameters- 
the baud rate, number of data bits, number of stop bits, and the parity- should be 
set to match that of channel 0 on the Allen-Bradley PLC.  Click on the ↓ by the 
Protocol selections and choose A-B DF-1 F/D since the Omnii-Comm will be 
using a full-duplex link with the PLC5.  Go to the options section and select 
Master since the Omnii-Comm will poll the PLC5.  P1 and P2 are now 
configured for this example program; click on Save and then Exit.  
Step 4:  Go to the Edit menu and select Header.  For this application, leave 
these values in thier default mode.  Click on the Ok to Save button.  
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Step 5: Go to the Edit menu. and click on Poll Tables.  Since we will only do 
one read and write operation in this example, we will only need one poll table.  
Go to the Poll Timer 10ms section and enter a polling rate value which will be 
multiplied by 10ms; if you enter 100 here, the Omnii-Comm will perform the 
read and write functions every 100*10ms = 1 sec.  Choose 100 for now.   
 
 Click on Poll Table to set up the poll table parameters.  Click on R to 
define what the Omnii-Comm reads.  Click on the ↓ next to the Connector 
selections, and select P2 so the Omnii-Comm will read from the PLC5.  Choose 
the location within the PLC as follows: PLC Type = PLC5, Command = PLC5 
Read, PLC DH+ Addr = 0 (this option only applies if the PLC is on the Data 
Highway), LP = 0 (this only applies to a PLC5/250), File Type = PLC5 Integer, 
File Number = 9, Starting Element = 10, # Bytes = 2. Click on Save. 
 
 Then, click on W to write the data previously read.  Click on the ↓ by 
Connector and choose P2 in order to write the data to the PLC5.  Set up the 
following parameters to write the data to this location within the PLC5: PLC 
Type = PLC5, Command = PLC5 Write, DH+ Addr = 0, LP = 0, File Type = 
PLC5 Integer, File Number = 9, Starting Element = 11, # Bytes = 2. Make sure 
the number of bytes read equals the number of bytes written.  Click on Save. 
 
 Next, click on E to set up the parameters that determine the location to 
write the poll table’s error code.  Click on the ↓ by Connector and choose P2 to 
write this error code to the PLC5.  Define the location within the PLC5 as 
follows : PLC Type = PLC5, Command = PLC5 Write, DH+ Addr = 0, LP = 0, 
File Type = PLC5 Integer, File Number = 9, Starting Element = 12, # Bytes = 2.  
Click on Save, then Exit.  The poll table is now complete. 

 
 Now click on System Error to define a global error location where the 
Omnii-Comm can write an error code in case a general error occurs. An error 
code is 2 bytes long; the high byte tells which protocol originated the error, and 
the low byte is the error itself.  A list of error codes is in chapter 7 under System 
Error Message Definitions.  Now click on the ↓ by the Connector selections 
and choose P2 so the Omnii-Comm will write this error code to the PLC5.  Now 
select the location within the PLC5 as follows: PLC type = PLC5, Command = 
PLC5 Write, PLC DH+ Addr = 0, LP = 0, File Type = PLC5 Integer, File 
Number = 9, Starting Element = 12, # Bytes = 2.  Then click on Save, Exit and 
Exit once more to return to the main screen. 
 
Step 6: Go to Save As in the File menu and save the program as a unique name.  
Then click on Control, this opens the Omnii Talk program. 
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CAUTION:    Before downloading the configuration to the Omnii-Comm: 
 
 A) press the black configuration mode button. 
 
 B) connect a 9-pin  RS-232 serial cable with a null-modem.  
 

Step 7: The Omniitalk screen appears in the help mode.  Hit F7 to make the 
RAM active and then hit F3 to send the configuration file to RAM.  After the 
file is sent, hit F4 to start the Omnii-Comm. 

 
Step 8: With the PLC-5 software, enter a value in N9:10.  This value should 
appear in N9:11 about one second later due to the Poll Timer Value in the poll 
table.  If there was an error, the error code will appear in N9:12 and N9:13. 

 
Step 9: For a real application, hit F5 to move the configuration file from RAM 
to EEPROM and then hit F8 to make EEPROM active; this puts the file into the 
non-volatile EEPROM memory so that the configuration will stay in memory 
even when the Omnii-Comm is turned off. 

 
This simple configuration will gives a good idea about how the Omnii-

Comm can be configured.  Display the file or obtain a printout of the configured 
parameters with the Display or Print options under the File menu in the Omnii-
Config program.  
 
Example 2 
 

This next example sets up the Omnii-Comm as a Modbus slave. 
 

After completing this tutorial, the Omnii-Comm will: 
 Use P1 to read two bytes from N9:0. 
 Write two bytes to the Modbus database as a holding register. 
 Use P2 to emulate a Modbus slave port supporting one holding register. 
 

The equipment used in this demonstration is a PLC5 (with a RS-232 
port), a 166-500 Omnii-Comm base module, a personal computer, a 9-pin serial 
RS-232 cable with a null-modem to connect Port 1 of the Omnii-Comm to a 
serial port on the P.C., a cable (M.A.R.C. cable #127-073-12) to connect the 
PLC5 to Port 2 of the Omnii-Comm, PLC-5 software, a Modbus master device 
and a 9-pin serial RS-232 cable with a null-modem to connect P2 of the Omnii-
Comm to the serial port of the Modbus device.  Set the communication 
parameters for the PLC5 serial port to: 

• 9600 baud 
• 8 data bits 
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• 1 stop bit 
• no parity 
• CRC error checking 
• DF-1 Full Duplex                    

 
Step 1: Click on File and select New from the list to open a new file. 

 
Step 2: Click on Protocol Maintenance in the Edit section and add Modbus 
and A-B DF1 F/D to the current set; the current set list holds a maximum of 
five different protocols. 

 
Step 3: Select Connector from the Edit menu to configure the connectors.  The 
first screen is for connector P1; click on the ↓ by the Protocol selections and 
choose A-B DF-1 F/D as the protocol.  Next, setup the baud rate, number of 
data bits, number of stop bits, and the parity to match that of channel 0 on the 
Allen-Bradley PLC.   Check the box beside Master (the Omnii-Comm will be a 
master to the Allen-Bradley PLC).  Leave the box next to BCC blank in order to 
select CRC error checking (CRC is a more thorough and reliable error checking 
algorithm). Then click on the ↓ by the Channel options and choose UART 1 
Chan A for Port 2.  This UART lets the microprocessor communicate with the 
port.  Each port requires a unique UART setting- no two ports can use the same 
UART.  Now, click on Save and then Next- this opens the screen for connector 
P2.  Click on Enable and select Modbus as the protocol. Select the baud rate, 
number of data bits, number of stop bits, and the parity required by the Modbus 
master device.  Leave the box next to Master blank- this configures P2 as a 
slave.  Select ASCII or RTU depending on the version on the Modbus master 
device.  Click on Save before exiting the screen. 

 
Step 4: Click on Header in the Edit menu.  Select Modbus as the Database 
Protocol since the slave connector P2 accesses the database.  Set the RTU 
address to the address the Modbus master device will use to send the Omnii-
Comm messages.  Leave the other values in their default state.  Click on Ok to 
Save. 

 
Step 5: Go into the Poll Tables section in the Edit menu. Since we will only do 
one read and write operation in this example, we will only need one poll table.  
Go to the Poll Timer 10ms section and enter a polling rate value which will be 
multiplied by 10ms; if you enter 100 here, the Omnii-Comm will perform the 
read and write functions every 100*10ms = 1 sec.  Choose 100 for now. 

 
Click on Poll Table to set up the poll table parameters.  If the program consists 
of multiple poll tables, any poll tables that write data to the database need to be 
done before any poll tables that write data to a connector.  The word next to Poll 
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Table 1 tells which portion of the poll is currently shown.  Click on the R to 
view the read section.  Select the PLC Type, Command and File Type.  Since 
P1 of the Omnii-Comm is connected directly to Channel 0 of the PLC, the PLC 
DH+ address is inapplicable and the LP only applies to a PLC 5/250.  Now, 
read from File Number 9, Starting Element 10 and 2 Bytes Expected and click 
on Save (always click on save after making a change before clicking on W or E 
or Ext to update the write, error or extension part of the poll - otherwise, the 
change will not be saved). 

 
Click on W and select Database as the connector, this tells the Omnii-Comm 
where to write the data.  Click on Save and then Ext.  This extension table sets 
up the database.  The order in which the poll tables are set up determines the 
order of registers within the database.  For example, if poll table 1 writes two 
holding registers to the data base and poll table 2 writes three holding registers 
to the database, the third holding register in the database is the first holding 
register of poll table 2.  After, setting up the database extension, click on Save. 

 
Click on E to set up the parameters that determine the location to write the poll 
table’s error code.  Click on the ↓ by Connector and choose P2 to write this 
error code to the PLC5.  Define the location within the PLC5 as follows : PLC 
Type = PLC5, Command = PLC5 Write, DH+ Addr = 0, LP = 0, File Type = 
PLC5 Integer, File Number = 9, Starting Element = 12, # Bytes = 2.  Click on 
Save, then Exit.  The poll table is now complete. 

 
Now, click on System Error to define a global error location where the Omnii-
Comm can write an error code in case a general error occurs. An error code is 2 
bytes long; the high byte tells which protocol originated the error, and the low 
byte is the error itself.  A list of error codes is in chapter 7 under System Error 
Message Definitions.  Now click on the ↓ by the Connector selections and 
choose P2 so the Omnii-Comm will write this error code to the PLC5.  Now 
select the location within the PLC5 as follows: PLC type = PLC5, Command = 
PLC5 Write, PLC DH+ Addr = 0, LP = 0, File Type = PLC5 Integer, File 
Number = 9, Starting Element = 12, # Bytes = 2.  Then click on Save, Exit and 
Exit once more to return to the main screen. 

  
 

Step 5: Click on Save As in the File menu and enter a name.  Exit the Omnii 
configuration program by clicking on Exit in the File menu. 

 
CAUTION:    Before you download the configuration to the Omnii-Comm, 
make sure that you: 

  A) have pressed the small black configuration mode button. 
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  B) have a 9-pin  RS-232 serial cable with a null-modem connected  
  properly. 
 

Step 6: Go to the download program by exiting the Omnii-Config program.  At 
the DOS prompt in the same directory, type CT and hit enter.  This program 
sends the file created by Omnii-Config to the Omnii-Comm.   

 
Step 7: With your PLC-5 software, enter a value in N9:10.  This value should 
appear in N9:11 about one second later due to the Poll Timer Value in the poll 
table.  If there was an error, look in N9:12 and N9:13 for the error codes. 

 
Step 8: Now go to the download program and select Transfer to EEPROM, 
then select EEPROM Active to transfer the configuration to the non-volatile 
EEPROM memory so that the configuration will stay in memory even when the 
Omnii-Comm is turned off. 
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HARDWARE 
 

5.1  OBJECTIVES 
 

This section describes the hardware on the Omnii-Comm with which the user may 
need to be familiar. 

 
5.2  HARDWARE  

 
5.2.1  Hardware Options 

 
The Omnii-Comm as a protocol converter allows multiple devices, speaking 

different protocols, to communicate.  Here is a list of the different models: 
A) Allen-Bradley 1771 rack mounted Omnii-Comm 
 166-500-XXX 
B) Allen-Bradley 1746 rack mounted Omnii-Comm 
 166-201 Omnii-Comm with FSK modem 
 166-202 Omnii-Comm with dial-up modem 
 166-203 Omnii-Comm 
 166-206 Omnii-Comm with additional RS-232 port 
C) Stand alone Omnii-Comm 
 266-001-XXX  requires 24 VDC power 
 266-002-XXX  requires 120 VAC power 
D) Allen-Bradley 1746 and 1771 rack mounted modems 
 166-100 2400 baud dial-up modem for 1746 rack 
 166-101 1200 baud FSK modem for 1746 rack 
 166-010 2400 baud dial-up modem for 1771 rack 
 166-010-144 14.4K baud dial-up modem for 1771 rack 
 137-001       1200 baud FSK modem for 1771 rack 
 X could be: -1  RS-232 driver/receiver for P3 or P4 
   -2  RS-422/485 driver/receiver for P3 or P4 
   -3  2400 baud dial-up modem for P3, P4 or Modem. 
   -4 1200 baud leased line modem for the modem port. 
   -5 14.4K baud dial-up Modem for the modem port. 
   -6 RS-232 driver/receiver for the modem port. 
   -7 RS-422/485 driver/receiver for the modem port. 
 
5.2.2  Diagnostic Lights 
 
 The diagnostic LEDs on the Omnii-Comm include the Transmit and Receive 
indicators for each port, an Active/On Line(heartbeat) and Error light.  Some common 
LED scenarios are listed below. 
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 Active/On Line LED is solid:  There is no configuration loaded or active. 
 

Active/On Line LED flashes: There is a configuration loaded, and the unit is  
                       attempting to run as configured. 
 
Error LED flashes:     There is a system error or poll table error; check the error   
 locations for error codes. 
 
TX LED flashes:        The Omnii-Comm is transmitting a message from the   
 specified port. 
 
RX LED flashes:        The Omnii-Comm is receiving a message on the specified   
 port. 

 
  These LEDs help determine connection errors and minor 

configuration errors.  For example, if the Omnii-Comm TX light flashes and the RX light 
for the same port does not, the cable for that port is bad or the other device is not 
responding to the Omnii-Comm.  Also see “Omnii-Comm Troubleshooting Tips” on page 
27.   

 
 

5.2.3 CONNECTOR PINOUTS  
 

 Typical pinouts for the Omnii-Comm: 
 

       RS-232                                           RS-422                                             RS-485(*See note below) 
 
   NC    1                                          TX+      1                              RX+        TX+   1                             TR+                    
 RXD   2                           TXD       RX+      2                              TX+        RX+   2 
 TXD   3                           RXD 
 DTR   4                                          GND     5                              GND        GND  5                            GND 
 DCD  6 
 GND  5                           GND         RX-     6                              TX-           RX-   6                            TR- 
  RTS  7                                            TX-      9                              RX-          TX-    9 
  CTS  8                                           RTS      7                                              RTS    7 
   NC   9                                           CTS      8                                              CTS    8 
 
        DE-9S                                            DE-9S                                               DE-9S 
 

*NOTE: When using RS-485 on Port 3 or Port 4 of the 166-500 or 266-001/002,  
                jumper pin 8 to pins 6 & 9.  Do not connect pin 7.    
See the “MARC Standard Cable Assemblies” booklet for more cable information. 

                                                                                         
5.3 JUMPER SETTINGS  
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 The following are user configurable jumpers. 

 
5.3.1  166-500 & 266-001/002 Jumper Settings 

 
PORT 1 AND PORT 2 SIGNAL LEVEL CONFIGURATION( RS-232 IS DEFAULT ) 

 
  Port 1  Port2 
166-500   JP1    JP2 
266-00X   JP2    JP1 

 
                            FOR RS-232                 FOR RS-422                 FOR RS-485  

 JUMPER PINS              JUMPER PINS              JUMPER PINS  
                                    4-6                                 3-5                                1-3 
                                    5-7                                 2-4                                2-4 
                                   8-10                               9-10                              9-11 
                                  13-14                             12-14                            12-14 
 
         5.3.2  166-500 & 266-001/002 MEMORY CHIP JUMPERS 
 

For 28 pin RAM and EPROM chips, set the jumpers as follows: 
 

166-500 MEMORY CHIP JUMPERS 
                                  
                                                                                                                                  · 

· 
· 

     
· 
· 
· 

                                                                                                                                                      
                                                                                                                                                        
                                                                                               
                                       

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

   J16       J6        J17      J14       J5        J2 
    

For a 32 pin EPROM, reverse J5. 
     

266-001/002 MEMORY CHIP JUMPERS        
 
 
 
 

 
                                        J9        J10      J11       J12      J13      J17 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

 
 For a 32 pin EPROM, reverse J12. 
 
 5.3.3  166-500 & 266-001/002 RESET BUTTON   
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The small black button by Port 1 can either be used to reset the Omnii-Comm, or 

put it in programming mode for configuration. 
 

166-500 RESET/CONFIG BUTTON 
 
 
                                                                                                                                               

 
                                                                                                
                                                J1                                 J1       

· 
· 
· 

· 
· 
· 

                                       Configuration                     Reset 
 
 

266-001/002 RESET/CONFIG BUTTON   
                                                                                                                                                                                
                                                                           

     
· 
· 
· 

                                                                         
                                                                                                                                         

· 
· 
· 

 
                                            

        J7                                  J7 
                                       Configuration                      Reset 
                                                 
 
 5.3.4  166-201/202/203/206 JUMPER SETTINGS 
 

The following jumper settings apply to the 166-201/202/203/206 versions of the Omnii-
Comm: 

 
PORT 1 AND PORT 2 SIGNAL LEVEL CONFIGURATION( RS-232 IS DEFAULT ) 

 
Use J1 for Port 1 and J2 for Port 2 on the 166-201/202/203/206 

 
 

                    FOR RS-232                    FOR RS-422                     FOR RS-485 
 JUMPER PINS                JUMPER PINS                 JUMPER PINS 

                           3-4                                   2-4                                    1-2 
                           7-8                                   6-8                                    5-6 
                         10-12                                9-10                                   9-10 
 
 
  
 

5.3.5  166-201/202/203/206 MEMORY CHIP JUMPERS   
 

For 28 pin RAM and EPROM chips, jumpers will be set as follows: 
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                                            J8             J10               J1             J2    
 
 For a 32 pin EPROM, reverse J1.   
    
   5.3.6 166-201/202/203/206 RESET/CONFIG BUTTON   
 

The small black button by Port 1 can either be used to reset the Omnii-Comm, or 
put it in programming mode for configuration. 

 
 

                                                                                                                                                     
                                                                                                                                             

                                                                                                                                             
               
                                                     J7                                 J7 
                                            Configuration                      Reset 
 
 

5.3.7  Modem Functions 
 

The following  jumpers apply when “Omniiserial Port 3” on the 166-500 or 
“Omniiserial U10” on the 266-001/002 is loaded with a modem module.  They also 

             apply for the 166-201 and 166-202. 
 

 
LEASED LINE MODEM SETTINGS: 

 
                               J1                 J3                                         J9                 J11 
                              J2                 J4                                        J10                J12 
                                   
                                   For 266-001/002                                         For 166-500 
 
 
 
 
                                                                 
                                                         

     J3          J4            J5           J6 
                                                                     For 166-201 

 
 

DIAL-UP MODEM SETTINGS: 
 
                      J1                   J3                                       J9                  J11 

· 
· 
· 

· 
· 
· 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 
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                                                J2                    J4                                       J10                  J12 
                                       
                                    For 266-001/002                                         For 166-500 

· 
· 
· 

 
 
                                                       
                                                         
                                                             
 
 

                                                             J3           J4            J5          J6 
 
                                                       For the 166-202 
 
 

-6 RS232 ADD ON BOARD SETTINGS: 
 

     J1                    J3                                       J9                  J11 
                                                J2                   J4                                        J10                  J12 
                                       
        For 266-001/2-XX6                       For 166-500-6XX 
       install a jumper on J8                   install a jumper on J13 

 
 

 
                                                                     
 
 
         

     J3           J4          J5          J6 
     For the 166-206 

install a jumper on J11 
 

 
DIAL-UP MODEM SPEAKER  

 
         Jumpered = enabled 
   J14                                                           J7              Open       =  disabled 

 • 
 •  

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

 •  •   • 
 •  •   • 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

· 
· 
· 

 • 
 •  

   
 

  
                                      For 266-001/002                         For 166-500 

 
 

DIAL-UP MODEM SPEAKER SELECTION  
For 266-001/001 and 166-500 

 
                                                                        JP3  •  •   • 

 •  •   •  
                                                         (U12)Port 5 
                                                         (U11)Port 4 
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                                                         (U10)Port 3 
 

 
 
 
 
 

Note: Speaker is not available on the 166-201/202/203/206  
  

 
PUSH TO TALK RELAY 

 
                                        J16                                    J8    J12  • 

 • 
 • 
 • 

 • 
 •  

                           For 266-001/002         For 166-500        For 166-201 
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JP1

JP2

12
34
56
78
9
11
13

10
12
14

2
4
6
8
10
12
14

1
3
5
7
9
11
13

J5
J6
J7

321

321

321
321

J10
J9

J11 J12
J13
J17
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  OMNII-COMM LEASED LINE MODEM FUNCTIONS 
 

The Omnii-Comm  lease-line modems operate the same for all of the 
different versions.   

 
  6.1  LEASED LINE CONNECTIONS 
 

An RJ-11 connector is used for connection to the phone line.  Use the RJ-
11 connector at the bottom of the 166-201, or the very last RJ-11 connector on the 
166-500 or the 266-001/002.  A standard modular phone line connector can be 
used.  The Omnii-Comm’s RJ-11 leased-line pinout is shown below.   

 
 
   
                                                                 
                                                         
 
                                                             1 2 3 4 5 6  

  RJ11 connector pinout 
 

 In this view, the mating end of the connector is facing   
            upward,  and the locking tab is at the rear of the connector.  
 
   1       Push To Talk output( remember to install jumper ) 
   2       RX+ (Yellow) 
  3       TX+ (Green) 
  4       TX- (Red) 
  5       RX- (Black) 
  6       Push To Talk common 
 

Use the Push To Talk signal to “key-up” a radio that accepts an FSK 
modem input.  The signal is a relay contact output that is enabled when the RTS 
signal goes high, and the modem is ready to transmit.  The relay close time can be 
changed by altering the RTS on/off delays in the “Connector” menu of the 
configuration program.   

For a 4-wire leased-line connection, reverse the transmit and receive wires 
so that the transmit output of one modem enters the receive input of another 
modem.   One possible connection is as follows: 
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Modem A         Modem B 

                                             Yellow       -       Green 
                                                Green         -       Yellow 
                                                Red       -        Black 
                                                Black     -        Red 
 

For a 2-wire leased-line connection, you will need to jumper the RX+ to 
TX+, and RX- to TX-, then connect these pairs to the same combination on 
another modem.  The connection scheme is shown below: 

 
Modem A              Modem B 

                                              Yellow, Green   -   Yellow, Green 
                                                 Red, Black     -      Red, Black        
 
 
 6.2  LEASED-LINE TRANSMIT LEVEL SELECTION 
 

The  transmit level is selected by setting an 8-position “DIP” switch: SW1 
on the 166-201, and SW2 on the 166-500 and 266-001/002.  For standard output 
levels, only one switch position should be on at a time.  Lower output levels can be 
obtained by turning on more than one switch at a time.  The following list shows 
the output level that will be obtained by setting one particular switch at a time. 

 
Switch Position      Output                                               

                                                              1                 +2 dB 
                                                              2                   0 dB 
                                                              3                  -2 dB 
                                                              4                  -4 dB 
                                                              5                  -6 dB 
                                                              6                  -8 dB 
                                                              7                  -10 dB 
                                                              8                  -12 dB 
 
 
 6.3 LEASED-LINE MODEM MODE SELECTION 
 

The modem is located on a plug-in module in the Omnii-Comm.  On the 
166-201 the module is located at the bottom of the card, on the 166-500 the 
module is located in the Omniiserial Port 3 position, and on the 266-001/002 the 
module is located in the Omniiserial U10 position.  There will be a 7 or 8 position 
“DIP” switch either on the top or bottom of the plug-in module that you will use to 
select the operating mode of the modem.  The factory default is Bell 202 Full 
Duplex.   
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1     2     3     4     5     6     7     8               MODEM OPERATING  MODE                                                                                         

X    X    1     1     1     1      1    X          Bell 103 Originate, 300 bps, full duplex 

X    X    1     1     1     1      0    X          Bell 103 Answer, 300 bps, full duplex 

X    X    1     1     1     0      1    X          Bell 202 1200 bps, half duplex 

X    X    1     1     1     0      0    X          Bell 202 1200 bps, half duplex with equalizer 

X    X    1     1     0     1      1    X          CCITT V.21 Originate, 300 bps, full duplex 

X    X    1     1     0     1      0    X          CCITT V.21 Answer, 300 bps, full duplex 

X    X    1     1     0     0      1    X          CCITT V.23 Mode 2, 1200 bps, half duplex 

X    X    1     1     0     0      0    X          CCITT V.23 Mode 2, 1200 bps, half duplex with equalizer 

X    X    1     0     1     1      1    X          CCITT V.23 Mode 1, 600 bps, half duplex 

X    X    1     0     0     1      1    X          CCITT V.23 Mode 1, 600 bps, half duplex with soft turn off 

X    X    1     0     0     0      1    X          CCITT V.23 Mode 2, 1200 bps, half duplex with soft turn off 

X    X    1     0     0     0      0    X          CCITT V.23 Mode 2, 1200 bps, half duplex with eq. & soft turn off 

X    X    0     1     1     0      1    X          Bell 202, 1200 bps, full duplex 

X    X    0     1     1     0      0    X          Bell 202, 1200 bps, full duplex with equalizer 

X    X    0     1     0     0      1    X          CCITT V.23 Mode 2, 1200 bps, full duplex 

X    X    0     1     0     0      0    X          CCITT V.23 Mode 2, 1200 bps, full duplex with equalizer 

X    X    0     0     1     1      1    X          CCITT V.23 Mode 1, 600 bps, full duplex 

 

 
X = Not Used, 0 = Switch Off, 1 = Switch On  

 
 6.4  RTS ON/OFF DELAYS  
 

RTS on and off delays are configured in the “MODEM” section of the 
“Connector” configuration menu, as well as the serial ports of the devices to which 
other leased-line modems are connected.  Many times PLCs will not communicate 
with the Omnii-Comm unless there is a sufficient RTS on/off delay configured in 
the Omnii-Comm and the PLCs.  Make sure that the “on” delay of the Omnii-
Comm is greater than the “off” delay of other devices in the system, and vice 
versa.       
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OMNII-COMM TROUBLE SHOOTING TIPS 
 
PROBLEMS & SOLUTIONS 

 
1. Problem - The Omnii-Comm does not respond with the OmniiComm 
prompt when the return key is pressed in OmniiTalk. 
 Solution- The cable from the P.C. to Omnii-Comm Port 1 is not a null 
modem cable or thesmall black reset button on the Omnii-Comm was not pressed 
before the download attempt.  It may help to cycle power on the Omnii-Comm and 
attempt downloading again.  Make sure that RAM is active. 

 
2. Problem - A “Start Poll” command is issued and the Active/On Line LED 
will not flash and the Error LED turns on. 
 Solution - There is a fatal configuration error in the Omnii-Comm 
configuration file.  Make sure that the following are consistent between the Omnii-
Comm and the devices it communicates with: error checking(CRC, BCC), baud 
rate, data bits, stop bits, parity, protocol, signal specification(RS-232, RS-
422/485), etc.  Make sure that the configuration program is saved correctly before 
downloading.  Check error locations for error codes. 

 
3. Problem - The Omnii-Comm starts to poll, but immediately turns on the 
Error LED, and there is no further polling activity from a port for up to 30 seconds, 
then another poll attempt is  made and the same thing happens again. 
 Solution - There is a minor configuration error in the configuration file, or 
possibly a minor hardware problem such as a bad cable.  Make sure that the 
configuration program is saved correctly.  Make sure to use the correct cable, and 
that the cable is installed properly.  Check to see if the Omnii-Comm and other 
devices in the system have valid addresses, and that there are no address conflicts.  
Check error locations for error codes. 

 
4. Problem - The Omnii-Comm seems (by watching the TXD and RXD LEDs 
on the Omnii-Comm) to transmit a message to another device, but the other device 
does not respond back, or it responds with a message that the Omnii-Comm does 
not understand. 

 

 Solution - Similar solutions as to Number 3 above.  This usually indicates a 
cable problem or an addressing problem.  Also make sure that baud rates, signal 
specifications(RS-232, RS-422/485), etc, are the same between the Omnii-Comm 
and the devices to which it is connected.  Make sure to issue valid commands to 
the Omnii-Comm and to other devices in the system.  Check error locations for 
error codes.
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SYSTEM ERROR MESSAGE DEFINITIONS 
 

7.1  OBJECTIVES 
 
 This section describes the error codes encountered in the Omnii-Comm. 
 

7.2  GENERAL INFORMATION 
 

 Error codes are stored as Hexadecimal words in the error locations defined 
in the configuration program(poll table & system error locations).  If the error 
code originates from the Omnii-Comm, the high byte of the error word indicates 
the PROTOCOL of the communication link that has an error, and the low byte 
indicates the SPECIFIC ERROR  that is occurring.  If an error is being reported 
by a device that is connected to the Omnii-Comm, the high byte will have its most 
significant bit set and the error code returned from the device will be placed in the 
low byte.   Example:  Error code 0BF5 indicates that there is an error with 
Modbus communication, and there is no response from the remote unit within the 
configured timeout period. 

 
 

7.3  ERROR CODES 
PROTOCOL NUMBERS                          TABLE INITIALIZATION ERRORS 
09      Modem                          10    illegal mode in header table  

0B      Modbus                                11     too many poll tables 

0C      Allen-Bradley DF1 Full-Duplex         12     illegal RTU type in poll table 

0D      Square D                                            13     illegal PLC type in poll address 

0E       MARC protocol                                 14     different RTU types in poll table 

0F       Control Applications                          15     wrong protocol selected 

10       Debug for SCI port                          16     illegal RTU count 

11       Reliance                                            17     too many points configured 

12       Allen-Bradley DF1 Half-Duplex     18     invalid info in poll table 

13       Omron                                              19      data table byte count 

14       3720 ACM                                       1A     error in RAM check 

15       American Dynamics 2150                1B      invalid port number 

16       Dukane                                              1C      error in database 

17       Caterpillar    1D      set CMD buffer full 

18       Dynalco TM 5000   1E      Gate Array Version 

19       Dynalco TEC 9000   1F       attempt to write across 2 PLCs 

              1A       Tejas 

 1B       Conitel 2020 
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 1C       GE Lighting 

 1D     Modbus Report by Exception 

 1E     Danload 6000 

20 ASCII 

21 Controlotron 

22 Tennessee Gas 

23 Data Aire 

24 Liebert 

25 CDC 44-560 

26 Multi Port Monitor 

27 Sutron 

28 SCI CSNET 

29 Sullair 
 2A    Brite 

2B     Amocans 

  
 SPURIOUS INTERRUPT ERRORS                  OMNII-COMM SYSTEM ERRORS 

20        SPI                                                            F0        stack error in TASKER    

21         pulse accum input edge                              F1        illegal command to BLDCMD 

22         pulse accum overflow                                 F2        transmitter buffer full 

23         timer overflow                                            F3       transmitter pointer queue full 

24         timer output compare 4                           F4        insufficient data returned from poll 

25         timer output compare 3   F5        no response from remote within  

       timeout 

26         timer output compare 2   F6        unable to send - no CTS from port 

27         timer output compare 1   F7        invalid state found in PTSTATE 

28         timer input capture 3   F8        error in RTU message 

29         timer input capture 2   F9         bad address in BLDCMD 

2A        timer input capture 1                                  FA        bad pointer in OUTQUE 

2B        real time clock    FB         CA download error 

2C        XIRQ     FC         Modbus command queue full 

2D        illegal opcode    FD Conitel MCD State Error 

2E         COP fail     FE Bad Pointer (RWE PTR, PCB, etc.) 

2F         COP clock fail 
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PORT/DRIVER INITIALIZATION ERRORS 

30          illegal port 

31          illegal protocol 

32          error in SIO configuration file 

33          wrong port or connector  

34 no protocol defined for port 

35 Illegal Parsing Instruction 

36 Protocol Extension Table 

37 Data size is not 2/4 bytes/element 

 
 

MODEM ERRORS 

40         invalid response from modem 

41 insufficient data in modem response 

42 Modem type not recognized 
 

43 Init string invalid or too long 

 
 

DRIVER I/O ERRORS 

70         SIO parity, overrun, or framing error 

71         CRC error code 

72         received byte error count 

73         receive buffer overrun 

74         transmitter buffer overflow 

75         illegal control code in received data 

76        illegal char. in received message 

77         illegal PLC address in received message 

78         error in receiver state byte 

79         error in xmitter state byte 

7A        error in timer state byte 

7B         error in received data 

7C         Square D link not established 

7D Illegal command 

7E Bad data returned 
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7F No data to return 

 

 

 

 FLOATING POINT ERRORS 

     81 floating point overflow error 

 81 floating point underflow error 

 85 division by 0 error 

 86 number too large or small to convert to integer 

 87 tried to take the square root of a negative number 

 88 Tangent of 90 degrees attempted 

 89 LOG or LN of negative number or 0 

 8A Arc Cosine not implemented 

 8B Arc Sine not implemented 

 8C floating point format error in ASCFLT 

 

Miscellaneous Errors 

50 Watchdog timer disabled 

51 Error in timeout program 

52 Caterpillar auto init failure 

53 Error in state byte 

54 Bad data or XD erect command flag or data 

55 Queue empty 

56 Post process procedure error 


